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Note: For this article, I have assumed you are using a Windows-based computer 
and have common office software (like Microsoft’s Word, Excel, and Access) 
loaded on your machine and have access to the Internet.  I also assume you 
know how to open, close, minimize and maximize software programs, navigate 
to folders and files, and save a file to a disk.  If you are using a different 
operating system, the concepts are applicable but the instructions are likely to be 
inaccurate. 
 
For many of us, the past few years have been challenging, to say the least.  
Many high-tech folks, baby bombers, manufacturing personnel, recent college 
grads and others have been facing a very difficult job market.  While networking 
is the source of most career opportunities, few of us pass up the opportunity to 
use the Internet and our computers to “cover all the bases.”  Near the end of 
this article, we will talk about some getting ready for the job search and how to 
set up agents.  In a later article, will talk about some job search web sites and 
how to research companies online.  But, for now, let us begin with some basic 
computerized job hunting tips and tricks. 
 
Although this is the computer and the internet age, many people find turning to 
their computer a scary endeavor.  I intend to break down some of these fears by 
break the tasks into less scary, manageable steps so that you can take 
advantage of this tool.  
 
Many major companies access resumes over the Internet IF you cut and paste 
your resume into their program or create or re-create your resume on their job 
site.  While this may be time consuming and a bit annoying to job seekers, it 
does provide uniform and safe input to the company.  So, it falls to the job 
seeker, in this economy, to cut and paste your resume in a text or ASCII format 
into the company’s candidate database. 
 
(ASCII stands for American Standards Code for Information Interchange. It is a 
format-free, special character-free, text-based standard that people have set and 
agreed to for exchanging information.) 
 
Even if the companies let you send job queries directly to their personnel 
department or the hiring manager, because of virus and security precautions, 
many companies do not allow employees to receive files over the Internet.  
Again, you will be asked to cut and past your resume into an e-mail message in a 
text or ASCII format. 
 
One thing that I learned pretty quickly in my job search is that many people who 
gather the information job seekers send to companies may or may not know 
enough about computers to save or print an attachment.  Even if they do know 
how to save or print an attachment and their company will let them receive 
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documents over the Internet, their company may not support the version of 
Word on your computer.  The short story is they are not able to read my resume.  
After talking to some of some of these people, they told me that they receive so 
many resumes that they do not usually have time to let applicants know that 
there was a problem.   
 
(You should not run into file size transmission limitations unless you are sending 
samples with graphic, video, or more complex files.  Some companies do not 
allow any files to be transmitted.) 
 
To ensure that potential employers could receive my information in an easily 
accessible format, I began doing the following: 

• Send a carefully written, targeted e-mail cover letter that concludes with a 
paragraph explaining which formats of my resume I am sending.   

• Attach a Word version of my resume saved to the earliest version of Word 
that I could unless the person I have talked to or their web site suggested 
something else. (As long as potential employers have a version of Word 
newer than the version you saved your file to, they will be able to bring it 
into their version of Word.) 
 
If my job market tended to use Apple software or something other than 
Word, I would have saved my file in Rich Text Format.  (Your file will end 
in .rtf.)  This format is more portable between different operating systems 
and word processing packages. 
 

• End the e-mail letter with a text (or ASCII) version of my resume. 
• Send a paper copy or fax copy of my resume (noting that it was a copy) if 

I was very interested in the position. 
• Call the potential employer after a day or so to ensure he/she received my 

information and to make a personal contact. 
 
Preparing Electronically for the Job Search 
In this section, we will talk about using your computer to get ready for the job 
search.  In this section, I will explain how to: 

• Create a text version of your resume (so you can include it in an e-mail 
message or paste it into a form at the target company’s web site). 

• Create blocks of text that can be used in a cover letter or e-mail message 
to highlight some of your skills.  Also, we will talk about using cut and 
paste to copy this information in the appropriate cover letter. 

• Get or create some networking cards. 
• Set up agents at appropriate web sites so software on the web sites 

automatically sends you job leads. 
• Introduce ways to maintain and use contact information. 
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After spending a lot of time creating and formatting that wonderful resume that 
you have, it may be a little difficult for you to see it turned into something less 
attractive.  But, in this job market, speed and content is, oftentimes, more 
important than presentation.  
 
(When you save your Word document to an earlier version of Word or to a text 
file, some of the formatting that you so carefully perfected may be lost because 
earlier versions of the software may not support the features that you used to 
create your work of art in a more current version.  Text editors will not read 
formatting commands at all.  So, before you send that resume anywhere, see 
how it appears saved as a Word 6.0/95 document.  The best way to do this is to 
copy the file onto a disk, take the disk to a computer with an early version of 
Word on it, and open the file.  Notice how it appears in that version of Word.  
See if you need to make any additional changes.) 
 
Saving your Resume to an earlier version of Word 
(.doc) or in Rich Text Format (.rtf) 
 
Here are instructions on how to save your Word document to an earlier version 
of Word or different file format.   
 
Remember to take advantage of your program’s spell and grammar checking 
software first.  (In Word, go to the Tools menu option and pull down to 
Spelling and Grammar. Release the mouse button. The Spelling and Grammar 
checking software checks your document and flags words, sentences, and 
punctuation marks it believes are incorrect.  Use your own judgment because 
while these tools are very helpful, they have limitations.  They will not, for 
example, catch the incorrect word spelled correctly.) 
 
When you have finished checking your document,   
 

1. Go to the top of your screen to the File menu.  Select File and pull down 
to Save As … and release the mouse.  A screen similar to the one below 
is displayed. 
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2. At the bottom of the Save As window, select the little arrow button to the 
right of the Save as Type field and pull down to the desired version of 
Word.  Release the mouse button.  The selected version of Word is 
displayed in that field. 

3. In the File Name field, enter some text that will enable to see that this 
file is the version saved to an earlier release.  (I usually end the file name 
with 60 or 695 when I save down to Word 6.0/Windows 95.)   
 
Note: You could also safely save the file to an .rtf file.   This file type 
should be easy to pull into other word processing packages written for 
other operating systems.  Some people, though, may not recognize the 
extension (.rtf) and tell you they do not know how to handle the file.  If 
you do save the file as an .rtf file, I suggest adding a note to the end of 
your cover letter explaining what you did and that the receiver can pull 
this into his/her word processing package.  Remember that an .rtf file is 
likely to be much larger that a .doc or .txt file.  
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Saving your resume to a text file 
 
Saving your resume to a text file is a little more … interesting.  First, you need to 
save your Word file to a text file and then, chances are very good that you will 
need to edit it to ensure the format of your resume is somewhat presentable and 
to change characters that might have been converted strangely.   
 

1.  Go to the top of your window to the File menu.  Select it and pull down 
to Save As … and release the mouse.  A window similar to the one below 
is displayed. 
 

 
 

2. At the bottom of the Save As window, select the little arrow button to the 
right of the Save as Type field and pull down to Plain Text (or ASCII 
text).  Release the mouse button.   
 
Note: When you save to a text file (Plain Text or ASCII), your graphics 
and most formatting is ignored.  Your word processing package may let 
you save to a text file that saves line breaks.  (This means that you won’t 
have one long line per sentence that you’ll have to break up so it will 
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remain in the viewing area.) If you have multiple options, you might want 
to experiment by saving your resume using these options.  
 
Remember to add something to the file name so you will remember 
which option you used that worked best for you.   
 
Remember that when you view or edit this file in your version of Word, 
the software pulls the saved text into your current version.  To retain the 
earlier version formatting, you need to use the Save As function as you 
did in this step. 
 
(Text files end in the extension .txt.  If you save your resume using 
different text options and do not add to or change the file name, your 
resume.txt file will be over written by the most recently saved file.) 
 
Remember where you have saved your file.  
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3. After you save your file, you may get a message that explains you will 
lose formatting and graphics in the converted file.  (The graphics and 
formatting remains, however, in your original file. Even if you use the 
same file name, the extension will be different.  Your Word documents 
end in .doc; the text/ASCII files end in .txt.  If you do not see the 
extensions on your window, go to the procedure “Changing the Way 
Information about Files Is Displayed” below.)  Select Yes. 
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4. Some versions of Word will show you a sample of your output and allow 
you to choose some additional options.   If you have these options, you 
can experiment with them and see the results in the Preview section of 
the window.  If you used bullets, for example, in your resume, you may 
want to have the system substitute a different character for the code 
string for a bullet or whatever the program has chosen to represent a 
bullet and the spacing following it.  When you think you have gotten the 
computer to do the translation about as good as it can, select OK. 
 

 
 

5. Minimize or close your word processing package.  
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6. Because word processing packages add formatting commands to files that 
you do not see when you are in the package, you need to edit the text file 
with a different program—a program that shows you exactly what your 
results will be.  Fortunately, if you are using Windows, Microsoft provides 
one for you.  To edit your text file, go to Start  Programs (or All 
Programs, if you are using XP)  Accessories  WordPad. 
 
The following graphic was captured on a Windows 98 machine so it may 
be different than yours. 
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The following graphic was captured on a Windows XP machine so it may 
be different than yours. 
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7. When WordPad opens, go to File  Open. When the Open window is 

displayed, navigate to your text file.  At the bottom of the window, select 
Open. Your text is displayed in the WordPad window. 
7a.  Go to the File menu and pulled down to Open.  Release the mouse 
button. 
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7b.  When the Open window appears, move to the appropriate folder and 
find the text file you want to edit.  (Ensure that the Files of Type field 
(specified on the bottom of the window) is set to Text Documents 
(*.txt) or All.  If the Files of Type field is set to Word, for example, text 
files will not appear.)  At the bottom right of the Open window, select 
Open.  Your text file is displayed in WordPad. 
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8. Edit your text file so that it appears exactly as you want it to appear.  
When you are done, select File  Save.  Then, Exit or minimize the 
program. (To Exit, go to File  Exit.  To minimize the program, select 
the minimize icon (the minus sign at the top right on the window.). 
 

 
 
Remember that if you exit any program and tell the computer not to 
keep information on the Clipboard, it will not be available to you because 
the Clipboard is “cleared” when you exit.  You want to select the option 
that keeps the information on the Clipboard.  (See sample screen shot 
below.) 
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9. Now, when you need to send your resume in text format in an e-mail 
message or when you need to paste it into a form at your dream 
company’s web site, all you have to do is go back into WordPad and copy 
the edited text and paste it into the e-mail message or into the company’s 
form. 
 
 



Schanstra Article  First North American Serial Rights 

 15/33 

Changing the Way Information about Files Is 
Displayed 
 
 
If you do not see the information about the files in your directory that you want 
to (for example, if the extensions do not appear), you can change the way 
information is displayed by following these instructions. 
 
1.  Navigate to the folder in which your file is located. 
 
2.  At the top of the window, select the View menu option.  Pull down to 
Details and release.   
 

 
 
3. If you still do not see the information you desire, you probably need to move 
the scroll bar (at the bottom of the window) to the right. 
 
Copying and Pasting Blocks of Text  
Sometimes, you get the wording exactly right and you do not want to lose it.  
Sometimes, you just want to save time.  Because I was applying to a few basic 
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kinds of jobs that required certain skills and experiences, I created a Word file 
that had copies of my favorite paragraphs and lists of reasons 
(projects/experiences) why I was qualified for a specific position.  I saved bullet 
items of projects, experiences, and success stories by category so searching for 
the right text was pretty easy. By selecting from these prepared lists and editing 
them, I felt I had the best of the best to choose from.  Oftentimes, I could copy 
and paste these paragraphs into forms on different company’s web sites.  
(Because many forms do not have spell and grammar checking software, 
checking your text in Word gives you an advantage.) 
 
You want to target your skills and experiences to each specific position but you 
want to spend your time wisely.  This set of “standard” paragraphs that highlight 
your strengths and experiences should be used to match the employer’s needs.  
If these paragraphs changed, I also saved them to the Word file.  After you 
perfect your masterpiece, run spell and grammar checking software on that file 
and proof read the text carefully, you can copy and paste it into other 
documents.   This retains the original in a file you can use later, if you desire 
 
So, for example, if a job ad requested someone who had a wide variety of 
technical writing experience, I would select blocks of text that provided examples 
of my experiences with various technical writing projects for various audiences 
using different authoring tools.   
 
Hint: Pick examples that use concrete results (dollars saves, number of items 
processed, percent improved, for example).  When you paste all of your 
accomplishments in the file for this employer, you can re-read the ad and re-
evaluate the information you have about the company to select the most 
powerful statements that show you are qualified for this position. 
 
 To copy a block of text,  

1. highlight the desired text.  (Move the cursor over the text so that the text 
appears in reverse video.)  
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2. Then, go to the Edit menu option and pull down to Copy.  Release the 
mouse.  The highlighted text goes to a temporary storage space, called 
the Clipboard on a Windows computer. 
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When you select Copy, a copy of the text is held in a temporary storage 
area (sometimes more technically called a buffer), called the Clipboard, 
and remains in your file.  The text remains on the Clipboard until you exit 
the program (and tell the program not to save the text).  In earlier 
versions of Word, remember that if you save more than one block of text 
(or photo or graphic) on the Clipboard, it overwrites what you saved 
before.  (More recent versions of Word, however, allow you to save more 
than one item on the Clipboard.)  
 
If you are copying the text within the same file, you can paste it using the 
steps below.  If you are copying the text into a different file, you need to 
get into the next program and file. 
 
You can leave the current program up, if you think you will be using it 
again soon.  Just minimize the program.  (Select the – icon on the upper 
right-hand corner of the window.) When you want to return to the first file 
or program, maximize the block of text (in the bar on the bottom of your 
window, near the start button.)  If you leave the program running, you do 
not have to worry about clearing the Clipboard when you exit the 
program.  You do still have to worry about overwriting the Clipboard. 
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If you exit the program and something is on the Clipboard, the system  
asks you if you want the information to remain on the Clipboard for other 
applications to use.  If you get this message, select yes so the information 
remains available for your use. 
 

 
To paste your text, 

1. Open the new file or application. 
2. Move the cursor to the location where you want the text to be pasted. 
3. Go to the Edit menu option.  Pull down to Paste.  Release the cursor. 

 

 
 

Note: You can paste the same text in more places, if you wish, until you 
close the program or put something else on the Clipboard. 

 
 
 
Creating Networking Cards 
If you go to a networking club or have read some of the recent job hunting 
articles, you will find that many people recommend the networking card.  
Networking cards are very similar to business cards but the ones that seem the 
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most effective are printed on two sides.  The first side has the usual information: 
your name, title or area of expertise, address, phone number, fax number, cell 
phone number, e-mail address, web site, and other information.  On the other 
side, many people list the areas where their talents excel.  Or, if you are going 
into your own business, on the other side you could list the products or services 
that you are marketing. 
 
Depending on your needs and budget, you can create the cards yourself or have 
someone else create the cards for you.   
 
If you are a do-it-yourselfer, you have a few options.  You could create the cards 
using a program, such as Word or Microsoft Publisher or use a web-based card 
creation site, such as VistaPrint.com.   
 
One package I find very easy to use for business cards is Microsoft’s Publisher.  
You can probably get a copy of Publisher for less than $100 (or less at a used 
software store) and it provides templates for business cards, as well as other 
business stationery and marketing vehicles.  If you select an office supply 
product from one of the vendors listed in the software, ensuring the information 
prints correctly on the stock is a piece of cake.  Just select the appropriate form 
number.   
 
Remember that the better the printer you use, the better your output.  If you 
do not have a photo-quality printer, maybe some of your friends will let you do 
some printing on their printers.  You may also be able to take your file to a 
neighborhood office reproduction center and have them print from your file.  
 
Hint 1: Use the finely perforated cards. While their edges will not be as sharp as 
edges cut at a printer's, they can almost pass. 
 
Hint 2: If you want to print on the back of these cards, you will probably find, as 
I did, that the less expensive card  stock will accept ink on both sides while some 
of the more expensive cards will not.  (The print just smears.) 
 
If do not have money for more software, do not despair.  You can write your text 
and, with some experimenting, copy and paste the information so it will fit on 
the form you have selected.  (This is, of course, more time consuming, but has a 
lower initial outlay.) You can use or copy the templates (provided in most 
business card stock packages) to check the spacing on  regular paper without 
printing on the more expensive card stock. 
 
If neither of these ideas sound good to you, you can go to the web.  Go, for 
example, to www.vistaprint.com.  This site will allow you to create “free” 
business cards in a limited number of formats with a subset of available graphics 



Schanstra Article  First North American Serial Rights 

 21/33 

and/or photos.  You do have to pay for shipping. At Vistaprint, if you want to use 
any of their non-free designs, you will be charged extra.  If you want to move 
the text, or print on the back of the card, there are extra charges.  But, these 
cards can make a very professional impression.  If you go for the “free” cards, 
shipping may take weeks.  Also, on the back of the free cards, you will see a 
small ad for the printing firm. I have done some upgrading on these cards and 
noticed they were shipped promptly.  From time to time, Vistaprint has specials 
that can save you some money.  They also have capabilities that allow you to 
make other customized office stationery products. 
 
 
Setting up agents at appropriate web sites  
 
Although statistics show that most people find most of their jobs through 
networking, do not overlook some of the resources on the Internet.  Many 
people in the job clubs I have joined find jobs through job boards, such as 
Monster.com, Career Builder.com, and web sites of their target companies.  I 
would suggest using any web site that a professional organization in your area 
has created, job search web sites from your college or university, association job 
web sites for your profession, and sites serving the area in which you want to 
work first.  I have found a much better response rate at these sites.   
 
When an employer posts a job at a site like Monster.com, the employer is likely 
to be buried in responses.  If your resume matches their job description very 
closely, you might get a response but, otherwise, you may never hear from them 
again.  Searching all these sites could be a full-time job but, fortunately, many 
sites let you set up agents.  These software programs search the web site and 
send you e-mail when a job or jobs meet the criteria you have set for that agent. 
 
Each site is likely to have different ways to set up an agent but, for this example, 
we will use monster.com.  I have set out some basic steps and provided more 
details for Monster.com. 
 
1. Go to the job web site.  If the agent has a link that directs you to set up an 
agent, select it.  Otherwise, select Search Jobs. (You might have to perform a 
search before you will be prompted to save it as an agent.) 
 
You will probably need to set up an account on the system so that you will have 
some security and so that the program will know where to send the listings.  Be 
careful about information you transmit over the web.  A legitimate job search 
company will not ask you for credit card information, your social security card 
number, etc.   Be aware. 
 
You will also probably be prompted to refine your search so that you are not 
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buried in job leads that you would find inappropriate.  I would suggest trying a 
search or two with the criteria you define before you make it an agent.  You 
might want to tweak the job location area after you find out, for example, what 
cities are included in a certain major city search.  Or, the job titles you are 
looking for may be hidden in a category that you would not have expected. 
 
You will probably also be asked how frequently you want to be notified about 
new positions. 
 
You may be asked if you want to hear about full-time, part-time, contract or 
other types of positions. 
 
Example: 
   1a.  On Monster.com, you need to select Search Jobs first.  (Some other sites 
also allow you to set up agents after you have searched for jobs.  Then it will 
often save your criteria as an agent.) 
 

 

 
  1b.  Select Click here to get started. 
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   1c.  Select My Monster Login.   
  1d.  If you are not a member, under Not a Member yet? select Continue. 
          Fill out the member information form. 
        If you are a member, enter your user name and password.  Select Login. 
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1e.  Under My Job Search Agents, select Create New Agent. 
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1f. Select Create New Agent. 
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1g.  Enter or select the criteria of the job lists you would like to have delivered to 
your e-mail address.  Select Save Agent. 
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1h. Select View. 
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1i. Review the detailed job description.  Apply to appropriate positions following 
the instructions given. 
 

 
 
2.  After your agent has been saved, check the e-mail account to which you had 
your positions sent frequently.  If you set up the agent to update you daily, 
check your e-mail daily.  If you set up the agent to send you mail weekly, check 
your e-mail weekly.  Some sites will send you a link to a page that will list jobs 
matching your criteria.  Some sites will send you actual listings of the positions. 
Some many send you an e-mail message containing a combination of these 
presentations. 
 
3.  When you have your dream job, remember that you will probably have to go 
back to the web site to turn your agent off.  (For this reason and others, it is a 
good idea to have a list of the sites where you have agents set up.) 
 
A word about posting resumes 
The only responses I have received from posted resumes were from contract 
houses and someone trying to sell me something.  I would suggest that you 
keep your private information under your control. 
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My dream company’s web site does not have agents 
If the company of your dreams does not have agents to help you set on top of 
their job postings, check out WatchThatPage.com.  This web site allows you to 
specify a page.  Whenever that page is updated, you will receive an e-mail 
message letting you know that something on the page has changed.  You still 
need to visit the page to see if your dream job has been posted but you do not 
have to worry about missing it. 
 
 
 
 
 
 
 
 
Maintaining and using contact information 
 
If are looking for a position while you are on unemployment, the government 
requires you to keep records of the companies to which you applied, how you 
applied, contact names, and so forth.  Even if no one is requiring you the keep 
information, it is a good idea to maintain this information for yourself because: 

• When a company calls you, you want to be able to converse with them 
intelligently about the position, where you found it, who you have talked 
to, and so forth. 

• You want to be able to contact companies at various times to check on 
the status of your application.   

• You want to be able to see where your best leads are coming from to you 
can do the things that give you the best results. 

• You may want to send form letters to the companies to which you have 
applied at a latter date. 

• You want to be able to track costs (plane tickets, limos, mileage, tolls, 
parking fees, business lunches and other legitimate business expenses) 
relative to your job search so you can deduct them from your income 
taxes, if appropriate. 

 
Maintaining contact information 
 
I like to use a database for my job search record keeping because it allows me to 
sort the information is many different ways.  You can also use Excel to do some 
sorting but a database, such as Access, is much more flexible.  (If you do not 
happen to have Access or Excel on your machine and cannot afford more 
software right now, using Word will allow you to do some searching through the 
Edit  Find command.)  You can use Access or Excel to perform automatic 
calculations for you (such as adding up job search expenses for your taxes). If 
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you have never used Access or Excel, you will need to invest some time to learn 
about the programs but I think you will find the time well spent.  And, you can 
add some new skills to your resume! 
 
The columns that I have found helpful for a database include: 

 Contact Name 
 Contact Title 
 Company Name 
 Company Address 
 Company City 
 Company State 
 Company Zip Code 
 Phone Number 
 Fax Number 
 Web site address 
 Lead Origin (for example web site, newspaper, or networking) 
 Publication Date of Lead  
 Position Title 
 Key skills needed for Position 
 Personal or Networking Contacts at Company 
 Date of Initial Contact 
 Initial Contact Name 
 Initial Contact Title 
 Initial Contact Phone Number 
 Initial Contact email address 
 Date of First Follow Up 
 Date of Second Follow Up 
 Date of Third Follow Up 
 Date of Interview 
 Interview Contact Name 
 Interview Contact Title 
 Interview Contact Phone Number 
 Interview Contact email address 
 Date Thank You cards were sent 
 Thank You cards sent to Names 
 Interviewer Name 1 
 Interview Name 1 Title 
 Interview Name 1 Phone Number 
 Interview Name 1 email address 
 Interviewer Name 2 
 Interview Name 2 Title 
 Interview Name 2 Phone Number 
 Interview Name 2 email address 
 Mileage to Interview and Back 
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 Tools 
 Parking 
 Hotels 
 Air Fair 
 Meals 
 Other expenses 
 Notes 

 
You may think of other information to capture.  I like to have this information 
available in case someone calls so having it in a file makes it readily accessible 
for me.  I can sort the information in different ways so I can quickly respond to 
questions more intelligently and talk about skills mentioned in their ad.  Also, by 
sorting on date fields, I can find out which companies and people I need to 
contact on specific days. 
 
If you would like a copy of an Excel spreadsheet for travel expenses, you may 
download on from our web site at www.lionsclubs.org/folder/file.  You will have 
to update it for the dates you desire and make any other changes but it is a free 
start.  Instructions for downloading the file are on the web site. 

 
Using a database and form letters 
 
By saving your database information to a text file, you can read it into other 
programs (such as Word) to further automate your job search.  You may want to 
automate thank you letters, initial contact letters, or do a mass mailing as part of 
your job search campaign.   
 
If you plan on contacting some companies in a mass mailing, explore Word’s Mail 
Merge and Letters Wizards.  Although this may seem “advanced” at first, I am 
sure you will see how easily the computer can help you make a professional 
presentation and assist you in attracting the attention of the decision makers 
who can help you to your dream position.  We do not have the space in this 
article to go through all the details of these features but I hope this introduction 
gives you the confidence to explore it on your own. 
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Happy job hunting!!!! 
 
If you would like a copy of this article with all of the screen shots, it is available 
in .pdf format on our web site at http:  
www.lionsclubs.net/folder/article_filename.  If your system did not come with a 
version of Acrobat Reader or you  have not downloaded a reader for .pdf files, 
you will need to do so.  The web site provides a link to the appropriate web site.   
 
(A .pdf file is a file that has been converted to a format more easily readily by 
computer users who have different software.  A .pdf file is in a portable 
document format that can display graphics and formatting similar to the original 
document to all who have the Acrobat Reader software.   Note that you cannot 
save a file to .pdf unless that is included as a Save as function in your Word 
processor or you have a more complete version of Acrobat.  The Reader is free.  
The version that coverts files to .pdf files is not.) 
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